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イントロダクション 

Tecplot Chorus は CFD プロジェクト (結果の評価にツールによる複数のシミュレーションケースが必要な

パラメトリックスタディなど) を管理する堅牢なフレームワークを提供します。システム性能の全体的な評価

と単独の環境で数十から数千というシミュレーションケースの視覚的な比較が可能で、これまで以上に確信を

持った素早い判断に導きます。 

このチュートリアルを始める前に 

このチュートリアルを始める前に User’s Manual の第 1 章 および 2 章をざっと読んで Tecplot Chorus のユ

ーザーインターフェースを確認し操作の基本概念に慣れておくことをお勧めします。各章を読む際は、

Tecplot Chorus を開いておき、実際に操作できるようにしておくと便利です。 

第 1 章 - イントロダクション 

Tecplot Chorus の初期画面、サポートされている入力装置、ワークスペース、メニューバーおよびグロー

バルツールバー、コンテキストメニューおよびツールバー、そしてサイドバーについて取り上げます。こ

のチュートリアルの内容を理解しやすくするために Tecplot Chorus  の主要なユーザーインターフェース

に慣れることをめざします。 

第 2 章 - プロジェクト 

初期画面、プロジェクトの基本、変数のプロパティ、ディレクトリの管理について取り上げます。続いて

これらの多くの概念を念頭に置きながら実践していきます。このチュートリアルが終了したら、再び 第 2

章に戻って参照してみるとよいでしょう。  
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このガイドにおけるチュートリアル 

この 『Getting Started』 マニュアルは、チュートリアルで分かれており、身近なトピックのさまざまな側面

をカバーするエクササイズが一つあるいはそれ以上含まれています。一般に、チュートリアルでは前半に概要

が詳しく説明されているため、順序どおりに参照してください。ただし、一度 Tecplot Chorus および 

Tecplot 360 EX を熟知したら、順番に参照しなくても問題ありません。 

以下のチュートリアルが用意されています。 

バーチャルツアー 

Tecplot Chorus に用意されているデータセットを使用して、さまざまな機能を検討します。Tecplot 

Chorus で最もよく使用される機能を概観するのに適しています。 

SO2 プルーム移行観察 

二酸化硫黄濃度を含む、産業用 CFD シミュレーションを使用して、実社会での Tecplot Chorus の使用に

ついて紹介します。 

電動アクチュエータの最適化 

航空機で使用される電子アクチュエータの設定を含む最適化の研究。設計空間で最高の結果をもたらす領

域 (スィート・スポット) の発見に役立てることができる制約の可視化方法を示します。 

これらのデータセットは Chorus Getting Started Bundle からダウンロードできます。 

掘り下げて考察し、表示をマスターしてください。 

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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バーチャルツアー 

Tecplot Chorus は、CFD プロジェクト (結果の評価にツールによる複数のシミレーションケースが必要なパ

ラメトリックスタディなど) を管理する堅牢なフレームワークを提供します。システム性能の全体的な評価と

単独の環境で数十から数千というシミュレーションケースの視覚的な比較が可能で、これまで以上に確信を持

った素早い判断に導きます。 

このチュートリアルでは以下の項目を含む、Tecplot Chorus で最も重要な可視化機能を紹介します。 

• プロジェクトを開く 

• 使用可能なプロジェクトの表示 

• プロジェクト内のケースと関連付けられている画像とデータの表示 

ユーザーにとって最も重要なことは、このツアーで紹介された機能を実際に操作してみることです。これより 

Tecplot Chorus で可能なことやその目的を説明しますが、理解を深めるためには実際に製品を操作すること

をお勧めします。このツアーでは Tecplot Chorus に付属しているサンプルデータのみを使用しますので、デ

ータの混乱や消去を気にすることなく作業できます。データは Chorus Getting Started Bundle からもダウ

ンロードすることができます。 

プロジェクトを開く 

Tecplot Chorus に付属しているサンプルプロジェクトを開きます。サンププロジェクトは Tecplot Chorus の 

sampledata フォルダ内にあります。 

1. Tecplot Chorus を起動します。初期画面が表示されます。 

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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Tecplot Chorus を新規インストールした際に表示される初期画面では Recent Projects の下にサンプル

が表示されます。「Example1」がリスト表示されたらそれをクリックしてプロジェクトを開き、以下の手

順はスキップします。Example 1 がリスト表示されない場合は、次の手順に従ってください。 

2. File → Open Project を選択し、Tecplot Chorus のインストールフォルダ内の sampledata フォルダを

指定し、example1.chprj ファイルを開きます。 

すぐにプロジェクトが開かれます。初期画面が非表示になり、テーブルビューでプロジェクトが表示され

ます。 
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ツールバーにある View メニューまたは、ボタンを使用すると別の表示を開くことができますが、これか

ら紹介しますので、まだ何も開かないでください。 
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プロジェクトには何がありますか? 

入力パラメータ (または独立変数) のさまざまな組み合わせで実行する各シミュレーション

の結果、Tecplot Chorus における独自のレコードが生成され case (ケース) と称されます。 

ユーザーが各 Case (ケース) に指定するオプションの情報フィールドおよび関連する画像や

データファイルとともに、シミュレーションの入力 (独立変数) および出力 (従属変数)が記

録されます。情報のこれらの部分は 「データについてのデータ」(シミュレーションによっ

て生成されたソリューションファイルが実データ) のため、それらは総称してメタデータと

呼ばれることがあります。 

まずは既存のプロジェクトを確認し、そのレイアウトを見てみましょう。 

テーブルビューについて 

プロジェクトを開くと、すぐにテーブルビューが表示されます。テーブルビューは、ツールバーにある   

をクリックするか、View → New Table View を選択していつでも開くことができます。テーブルは以下の

ように表示されます。 
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視覚的観点からするとテーブルビューはあまり興味深い表示形式ではありませんが、プロジェクトにおける実

際の数値を確認するには非常に便利です。プロジェクトを開きテーブルは既に開かれていますので、ここから

開始します。 

テーブルビューの各行は、入力値の一意的な組み合わせと関連付けられた一つのケースを意味します。確認す

ると次のことがわかります。 

• 各ケースは行として示され、関連する値は列として示されます。各ケースは同じ一連の変数を持ちます。 
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• 各ケースには CaseID が数値で割り当てられます。最初のケース ID は 1 で、インポートされた新規の各

ケースには、さらに上位の次の番号が割り当てられます。これは、ほかのユーザーと特定のケースについ

て意見を交わす場合に省略表現として便利です。 

• 最も大きい Case ID が 191 であるため、このプロジェクトには 191 のケースが存在すると簡単に分かり

ます (一番下までスクロールダウンして確認してください) 。 

• Case ID の他に「Mach No.」、「Alpha」、「Beta」、「#Iterations」、「Lift」、「Drag Coef」、「Pitch 

Mom.Coef.」と名前が付けられた 7 つの列があります。右にスクロールするとこれらのすべてを確認する

ことができます。それぞれの列は変数を表しています。 

航空宇宙のエンジニアであれば、最初の 3 列は共通の独立変数 (シミュレーションへの入力) で、ほかは

従属変数 (シミュレーションからの出力) であるとお分かりになるでしょう。 

• 各セルの上部には薄くチェックマークが表示されています。これらのチェックマークは各セルの値がプロ

ジェクトの変数範囲に入る箇所であることを示し、左端では変数の最小値、右端では最大値を表します。

テーブルを下にスクロールすると Case ID のセル内のチェックマークは予想どおり左から右へ移動しま

す。チェックマークは他の列にどのように移動するか (必ずしも順序よくではありません) 確認してみて

ください。 

• シェーディングされている列や、赤字で示された値に気づくでしょう。このような表示でフィルタリング

の結果が分かりやすく視覚的に示されます。シェーディングはフィルタリングされている高い値と、低い

値の割合を意味します。赤色の値は列のフィルタリングを通過した値です。 
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プロジェクトには入力や出力ではなく、本質的に情報を含む変数を含めることもできます。これらの変数は日

付、シミュレーションを実行したエンジニアの識別、実行したクラスター、および似たような管理情報を記録

することができます。このサンプルプロジェクトにはこうした変数はありません。 

ケースおよび変数をプロジェクトに追加したり、Tecplot Chorus 内で変数を計算したりすることも可能です 

(詳細については、 Tecplot Chorus User’s Manual の Chapter 2 を参照してください) 。 

列のヘッダーをクリックすると、変数の昇順でテーブルをソートすることができます。同じヘッダーを再度 

(2 回目) クリックすると、降順にソートされます。これによりプロジェクト内で任意の変数の範囲を簡単に決

定することができます。試してみてください。 

Table View と同様に、選択したケースのみを表示することができます。View メニューから

Selected Cases を選択すると、この表示にすることができます。他のビューで選択したケース

の値を確認する際に便利です。 

マトリクスビューについて 

マトリクスビューを使用すると、ケースの一部またはすべてに関連付けられたサムネイル画像を使用して、プ

ロジェクト内のケースを視覚的に取捨選択することができます。行、列、およびオプションでページを割り当

てて、プロジェクト内で任意の変数を示すことができます。 

新しいマトリクスビューを開くには、View → New Matrix View を選択するか、ツールバーで  をク

リックします。マトリクスビューがテーブルビューの初期画面の隣または上に部分的に表示されます (使用可

能領域によって異なります)。 

ウィンドウを管理する 

ツールバーボタンをクリックしてビューを開いたりプロットしたりするたびに、既に開いて

いる場合でも、その形式で新規にビューやプロットが開かれます。新規ウィンドウは、少な

くともほかのウィンドウも一部見えるように配置されますが、常にそのスペースがあるとは

限りません。 
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ウィンドウを開いたときにそのプロットが既存のウィンドウを覆ったとしても、既存のウィ

ンドウは隠れているだけでそこにあります。プロットを新たに開いたとき、これまで丹念に

設定したプロットを失ってしまったかと懸念する必要はありません。既存のプロットは新規

プロットの下に存在しています。 

ツールバーにある   ボタンをクリックして、開いているすべてのウィンドウをグリッド

表示すると、目的のウィンドウを見つけやすくなります。 

初期画面 (ウィンドウサイズに応じて各ユーザーで異なる場合があります) で表示されるサムネイル画像はご

くわずかです。 
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画面が小さい場合は、ワークスペース全体を使用するようにウィンドウを最大化することができます。その場

合、ウィンドウ右下隅のズームスライダーを使用してサムネイルを最小化すると、マトリクスビューでさらに

多くのセルを確認することができます。以下のように表示できるはずです。 

 

このとき次の点が確認できます。 

• マトリクス内のいくつかのセルは空白です。サンプルプロジェクトでは、これらのいくつかは不明なケー

スで、実行されていないシミュレーションです。実際のプロジェクトでは、さらにまばらに表示されるこ

とがよくあります。 

マトリクスのセルが空白であるもう一つの理由は、そのセルに属するケースに関連付けられた画像が一つ

もないことです。しかし、このサンプルプロジェクトでは該当しません。 
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• 変数 Mach No. および Alpha がマトリクスの列と行にそれぞれ割り当てられました。これらの変数は変

更することができます。 

• 各変数の離散値は独自の行と列を得ます。 

ケースをいくつかクリックしてみてください。開いたテーブルビューがまだ表示されている場合、マトリクス

ビューでセルをクリックすると対応する行がハイライトされます。Tecplot Chorus では、一つのビューでケ

ースを選択するとすべてのビューでそれが選択されます。また、View → Selected Cases から選択されて

いるケースのみが表示される特別なドッカブル・テーブルビューを開くこともできます。 

マトリクスビューで複数のケースを選択することができます。マトリックスセルの代わりに行や列のヘッダー

をクリックしてみてください。セルやヘッダーをクリックしているときに Control か Shift、またはその両方

を押してみてください。以下を考えてみてください。 

1. 最も速く列 0.2、1.2、1.8 のみを選択する方法 

解答: 列 0.2 のヘッダーをクリックし、Control キーを押しながら列 1.2 および 1.8 のヘッダーをクリッ

クします。 

2. 最も速く最後の 3 つの行を選択する方法 

解答: 最後の行のヘッダーをクリックし、Shift キーを押しながら最後から 2 番目のヘッダーをクリックし

ます。 



バーチャルツアー 

16 

マトリクスビューのプロパティ 

 

サイドバーの Properties (プロパティ) パネルでマトリクスビューのオプションを選択することができます。

通常、Properties パネルはワークスペースの左側で確認することができます。Properties パネルが開かれて

いない場合は、View → Properties を選択して開いてください。 

形式が同じでも、開いたビューやプロットはそれぞれ固有のプロパティを持ちます。例えば、複数のマトリク

スビューを開いている場合、それぞれのマトリクスビューは独自のプロパティを持ち、他のマトリクスビュー

のプロパティからは完全に独立しています。 
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テーブルビューのプロパティについて 

テーブルビューのプロパティについては、設定が一つのみであり、またこのレッスンで触れて

いないフィルタリングに関係しているため説明を省略します。 

マトリクスビューを見てみると以下の内容が確認できます。 

• マトリクスの行と列で使用する変数を変更することができます。Alpha に対して Mach No. を、 Beta に

対して Alpha を試してみてください。 

• 3 番目の変数をページングに選択することができます。現在、行と列に Alpha と Beta を使用しているた

め、ページング変数として Mach No. を選択してみてください。それから、Properties パネルのスライダ

ーを使用してページを行き来してみてください。 

• 行、列、そしてページとしても、4 つの従属変数を使用することができます。通常これは特に有用ではあ

りません。ほとんどの場合、プロジェクトにはさまざまな従属変数の離散値があります。そのため、その

変数の行や列が数多く表示されることになり、画像が大きく広がって表示され操作しづらくなってしまい

ます。しかし # Iterations で試してみると、Mach No. とともに以下のように表示されます。 
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いくつかのセルには    印が付いていることに気が付きましたか? この印は、行、列、およびページとし

て表示されている変数の値が同じケースが複数あり、これらのケースのうち二つ以上が画像と関連付けら

れていることを示しています。印が付いたサムネイル上にマウスを重ねると、ツールチップによってその

セル内にいくつ画像が重なっているか確認することができます。マトリクス内でハイライトされた以下の

セルでは、1 つのサムネイル、そして 6 つの画像の合計 7 つ画像の存在が示されています。 

 

サンプルプロジェクトではすべてのケースに画像があるため、7 つの画像が 7 つのケースに対応します。

マトリクス内のセルを選択しテーブルビューに切り替える (または Selected Cases ビューを開く) と、こ

れら 7 つのすべてのケースが実際に選択されたことがわかります。 
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• Properties パネルの Show メニュー内では、オプションとして "Contour Image" のみが表示されます。

サンプルプロジェクトでは 1 種類しか画像がありませんが、各ケースは関連付けられた複数の画像を持つ

ことができます。このサンプルプロジェクトに、ケースと関連付けられた複数の画像があれば、このメニ

ューを使用してマトリクス内のサムネイルとして表示する画像を選択することができます。 

考察: 行、列、およびマトリックスの追加ページのために選択した変数に基づいてサムネイルが選択されます。

複数のケースがこれらの変数に一致し、かつ画像を持つ場合は、代表のケースが実際のサムネイルの表示に選

択されます。スライダーのラベルをオンにして、使用していない変数の値を確認することができます。それか

ら filtering を使用してこれらの値を間接的に選択することができます。ここではフィルタリングについて説

明はしませんが、Filters のサイドバーで試してみることをお勧めします。 

関連付けられた画像の表示 

マトリクスビューのすべてのサムネイルは、プロジェクトで一つ以上のケース (それに関連付けられた一つ以

上の画像を持つケース) を表しています。(画像を伴わないケースはランが実行されていないケースと同様に

空白で示されます。) これらの画像をマトリクスビューからフルサイズで表示する手順は次のとおりです。 

1. Properties サイドバーの Show メニューを使用して表示する画像の形式を選択します。サンプルプロジ

ェクトでは、Contour  画像のみが使用可能になります。 

プロジェクトに複数の画像形式がある場合、マトリクスビューに表示された画像形式以外で表示すること

ができます。マトリクスを切り替えて目的の画像形式を表示するとこれらの画像を持つケースの検索が容

易になります。 

2. 関連付けられた画像を表示するケースを一つ以上選択してください。 

関連付けられた画像を持たないケース (マトリクスで空白のセル) をいくつか選択したとしても問題あり

ません。その場合、画像の表示を指定しても表示されません。 

3. 選択した画像をポイントしながらマウスを右クリックし、View Images を選択します。画像が別のウィ

ンドウに表示されます。 
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ほかのビューのように、画像ウィンドウにも独自のプロパティがあります。以下の操作をしてみてください。 

• ラベルをオンにして、各ケース (ここに表示された画像ビューアーウィンドウのラベルは既にオンになっ

ています) に関連付けられた変数の一部またはすべての値を確認します。 

• 別の形式の画像を選択します。このプロジェクトには用意されていませんが、存在する場合はサイドバー

の Properties の Tag メニューから選択することができます。 

• 選択したケースのすべての変数値を表示します。画像をクリックするとサイドバーの右に表示されます。 

• 選択した画像との相違を示す画像を表示します。画像をクリックしてマスター (ほかが比較される画像) 

として選択します 。それから Diff From Current をクリックします。画像同士の違いとともに新規ウィ

ンドウが開かれます。 
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Congratulations! ビューでの動作はすべて同じです。これで、すべてのビューで画像および、それらの違い

を表示する方法を習得しました。プロジェクトを開いたとき (または新規プロジェクトを開いたとき) に開か

れたテーブルビューに戻り、行をいくつか選択して右クリックします。そこからは先の操作は同じです。以降、

Tecplot Chorus に用意されている 3 種類のプロットの紹介に向けてこの点を心に留めておいてください。 

関連付けられたデータの表示 

これまで、マトリクスビューからケースに関連付けられた画像ファイルを表示する方法を紹介してきました。

ケースは関連付けられたデータファイルを複数持つこともあります。実際、CFD のワークフローに慣れてい

るユーザーであれば、ソルバーやスクリプトで呼び出される典型的な後処理段階としてソリューションデータ

ファイルから画像ファイルが作成されることをご存じでしょう。Tecplot Chorus でもデータファイルから画
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像を作成できますが、それについてはこのレッスンでは触れません。まずはデータファイルを 表示する こと

のみに重点を置いて説明します。 

Tecplot Chorus は、Tecplot 360 を使用してデータを表示します。Tecplot 360 を使用すると、一般的な 

CFD ソルバーから出力される多様なデータファイルを読み込むことができ、そこから出力に対応したプロッ

トやアニメーションを作成し、生の結果についてさらに解析を実行することができます。 

Tecplot 360 を起動し、Tecplot Chours 内のケースに関連付けられているファイルを開くことを我々は 

"deep dive"  と呼んでいます。これまでサムネイルおよび、さらに大きな画像をいくつか確認してきましたが

これはプロジェクトにおける膨大なデータのうわべでしかありません。Tecplot 360 内のケースに関連付けら

れた実際のデータファイルを開けばプロットのズームや回転、等高線や軸ラベルの追加、スライスして分割す

ることなどが可能です。これによりデータから重要なアイデアを得ることができ、さらに深く掘り下げること

ができます。 

手順は画像の表示で説明した内容とほとんど同じです。唯一の違いは右クリックした後、View Image の代わ

りに View Data を選択することです。Tecplot 360 が起動し、選択したデータファイルが別のフレームにそ

れぞれ開かれ、制御できるようになります。 
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Tecplot 360 を操作しているとき Chorus というタイトルで追加されたサイドバーを確認することができます 

( このショットでは右側にドッキング表示されています) 。サイドバーには Tecplot 360 で動作する Tecplot 

Chorus の機能が含まれています。 

例えば、Chorus で画像を比較するのと同じようにデータを比較することができます。ほかのフレームと比較

したいフレームをクリックし、Set Current Frame as Master ボタンをクリックします。それから Show 

diff data チェックボックスをオンにします。 

Chorus のサイドバーにあるほかの機能も自由に操作してみてください。そして、以下の点を理解してくださ

い。 
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• View Page セクションで Tecplot Chorus で開かれたページを管理することができます。Tecplot Chorus 

でデータを開くたびにデータは新規ページに配置されます。Tecplot 360 の全体の新規インスタンスは開

かれません。 

• Label Frames セクションでプロットのラベルに表示される変数を選択することができます。 

• Save as Style Template ボタンでプロットのスタイル (外観) を別のファイルに保存することができま

す。スタイルは、ほかのデータファイルに自動的に適用して新規画像を作成することができ、Tecplot 

Chorus でアクセスすることが可能です。 

• Synchronize Styles ボタンで現在選択されているフレームからスタイル (外観) をほかのすべてのフレ

ームにコピーすることができます。 

今すぐに理解できなくても問題ありません。このレッスンでは、Tecplot Chorus の基本的な特徴に慣れるこ

と、および各機能の理解と習得を支援することを目的としています。Tecplot 360 についての説明が少し長く

なりましたが、これは独自で豊富な機能を持つ Tecplot Chorus とは全く別のアプリケーションです。セッシ

ョンのこのパートでは、Tecplot Chorus と Tecplot 360 の 2 つのアプリケーションが森と木のように密接に

統合されているということを示します。 

少し操作してみたら、Tecplot 360 を終了してください。次に Tecplot Chorus のプロットについて説明しま

す。 

プロット 

テーブルとマトリクスがあれば十分です。魅力的なグラフィックをいくつか見てみましょう。Tecplot Chorus 

では 3 つのプロットタイプが用意されており、ツールバーのボタンまたは、View メニューのコマンドを使用

してアクセスすることができます。 

 3D Scatter Plot (3 次元散布図) 

 2D Scatter Plot (2 次元散布図) 
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 Line Plot (ラインプロット) 

これよりそれぞれのプロットタイプを簡単に確認しますが、まずはプロットの操作に使用する以下のツールに

ついて説明します。 

 Select (選択) 

プロットや、ほかのデータビュー内の個々のケースやケースのグループを選択することができます。 

 Translate (移動) 

ウィンドウ内で 3 次元プロットを動かすことができます。2 次元およびラインプロットの場合、データが

移動する間、軸は所定の位置にとどまります (軸の範囲が変化します)。 

 Rotate (回転) 

3 次元プロットを回転することができます。2 次元またはラインプロットには使用できません。 

 Zoom (ズーム) 

プロットを拡大したり縮小したりすることができます。 

ツールがアクティブなときに、ズームするウィンドウ内にマウスポインターを置いて、マウス

のスクロールホイールを動かすとプロットをズームすることもできます。 

これらのコントロールは各プロットで若干異なった動作をします。違いを確認してみてください (または 

『Tecplot Chorus User's Manual』の Chapter1 を参照してください)。 

View → Reset を選択してプロットをデフォルト表示に戻します。 
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3D Scatter Plot (3 次元散布図) 

3 次元散布図は、Tecplot Chorus でおそらく最も見栄えの良いプロットで、ツールバーの  をクリック

するか、View → New 3D Scatter Plot を選択してアクセスすることができます。 

 

散布図内のそれぞれの球はプロジェクト内の単独のケースを示しています。これは、3 次元ですので回転させ

て楽しんでみてください。ツールバーにある  Rotate アイコンをクリックし、プロットウィンドウにド

ラッグしてください。別の角度からデータを見ると新たな視点が得られます。 



 プロット 
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Properties サイドバーには、散布図プロットの外観を変更できる多くのオプションが用意されています。(こ

こでは Surrogate Model (代用モデル) 項目の下のオプションについては取り上げません。) 特に以下の点に

注意してください。 

• X、Y、Z の軸に表示する変数を選択することができます。一般には、二つの従属変数を X と Y 軸に、一

つの独立変数を Z 軸に選択します。  

しかし、ときには別の設定を使用したいことがあるかもしれません。３番目の独立変数を使用するといく

つかのパラメータ値周辺のケースのクラスタリングを表示することができます。日付やスタッフメンバー

などの情報変数を Z に 使用すると、例えば「同じ日付」や「同じスタッフメンバー」などによってケー

スがレイヤー (各レイヤー上のケースがすべて実行された場所) に整理されます。従属変数を複数使用す

ると相関関係を表示することができます。 

• 各軸の範囲は変更することができます。デフォルトでは選択した軸の変数の最小値から最大値までのすべ

ての値が表示されます。 

• 各ドットのカラーを変数で決定することができます。この変数はプロットの軸上の変数の一つ、または 4

番目の変数です。変数の最低値は青、最高値は赤になり、中間の値はレインボースペクトルになります。 

サンプルプロジェクトでは、ケース ID による色付けは最初にインポートされたケース (青) および、後か

らインポートされたケース (赤) を表しています。または、#Iterations によって色付けすることができ、

解が収束するまでに要したケースの得た反復回数を示す色を割り当てることができます。 
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色の値のマッピングを示す凡例をオンにすることができます。凡例をプロットの周辺にドラッグして任意

の場所に配置します。凡例をプロットの上部か下部に動かしたとき、どうなるか確認してください。凡例

内の手順の概数を選択することもできます。 

• 変数の値で各ケースの色を決定できるのと同様に、サイズ も変数の値で決定することができます (球体か

ら正方形に変更することもできます)。Beta および倍率 0.5 で試してみてください。その後、立方体を試

してみてください。 

• 右クリックしてプロットを画像として保存することもできます。この機能も実際に試してみてください。

画像は Portable Network Graphics (PNG) 形式で保存されます。 
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任意のプロットまたはビューのインスタンスは各プロパティと共に複数開くことができることを思い出してく

ださい。二つの 3 次元散布図を開き、それぞれを異なった方法で回転させてみてください。また、Properties 

パネルを使用して各軸に独自の設定をして表示してみてください。 

散布図でケースを選択できることに注意してください。つまり、プロットからもプロジェクト内のケースに接

続可能で、プロットは単なるプロットではなくケースに接続する別の経路でもあります。 (Tecplot Chorus の

プロットはすべてこのように動作します)。ツールバーで   Select ツールを選択し、球体または立体を

いくつかクリックしてください。Control キーを押しながらクリックして複数のケースを選択するか、選択す

るケースの周囲を矩形にドラッグしてください。 

同期選択 

ほかのビューまたはプロットが開かれている場合、3 次元散布図で選択したケースがほかのビ

ューでも選択されることが確認できます。一つのプロットまたはビューで選択されたケースは、

すべてのプロットまたはビューでも選択されます。これは Tecplot Chorus における普遍的概

念です。この機能について繰り返し言及しませんが、心に留めておいてください。 

ケースか軸を選択したら右クリックします。マトリクスビューに関する説明で取り上げた画像やデータの表示

と同じオプションがここにもあります。実際に操作して同じように機能することを確認してください。 

2D Scatter Plot (2 次元散布図) 

2D Scatter Plot (2 次元散布図) は既に説明した 3D Scatter Plot (3 次元散布図) と似ています。X とＹ軸に

変数を指定するだけで実行でき、変数で散布のシンボルの色やサイズを指定することもできます。 

このサンプルプロジェクトでは、X と Y 軸にそれぞれ Alpha と Lift Coef. を持ち、#lterations 変数を使用し

て色付けされた 2 次元散布図を作成します。凡例を追加し、データの邪魔にならない場所に配置します。この

結果のプロットで、Alpha は Lift に対してほぼ線形の好ましい影響を与え、ほとんどのケースは 200-250 回

反復して収束することが分かります。 
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X 軸の変数を Beta に切り替えると、Lift に対する Beta の関係がさらに複雑であることが明らかに分かりま

す。 
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1 つの独立変数を別の従属変数にプロットすると、相関関係を明らかにすることができます。以下は、Lift 対 

Drag (Mach No.で色付けされた) プロットで、Mach No.、Lift と Drag は二次で正の関係があるように見え

ます。 
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3 次元散布図と同様に、2 次元散布図でも  Select ツールを使って画像やデータを表示することができ

ます。Control キーを押したり離したりしながらクリックしてみてください。また、ケースの周囲を矩形にド

ラッグしてみてください。次に右クリックして、選択したケースに関連する画像やデータを表示してください。 

フィルターを操作していて、色付けを "Color by Filter Violations" に指定している場合、プロジェクトに陰

影が表示されることがあります。これは軸変数に機能するフィルターの効果を視覚化します。各ケースは通過

したフィルターの数の応じて色付けされます (詳細については凡例を参照)。 
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Line (ライン) および Symbol (シンボル) プロット 

Tecplot Chorus のラインプロット (  ボタンまたは View → New Line Plot) は、各ケースのシンボル、

ケースを統合するラインまたは、シンボルとラインの両方を表示でき、実際には 3 つのプロットが一体になっ

ています。 

一見すると、ラインプロットは 3 次元散布図よりも地味ですが、結果のやり取りに幅広く使用できる手段です。

これからプロットを再現するので続いて操作してみてください。少し制限はありますが、コントロールはこれ

までほかのプロットで見てきた内容と同じです。3D 散布図と同様に、ここでも Properties パネルの 

Surrogate Model (代用モデル) については取り上げません。 
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軸に加えて、カラーおよび/またはシンボルシェイプを選択し、最大 2 つまでの変数を表示することができま

す。カラーまたはシンボルに変数を使用すると、その変数の離散値が各自のカラーやシンボルの形状を使用し

て、 (ラインがアクティブであれば) 独自のラインとして描画されます。 

 

このプロットに適用された設定が分かりますか? 

解答: X-Axis: Mach No. Y-Axis: Lift Coef. Show Lines. Sort By: Mach No. Color: By Variable/Alpha. 

Symbol: Shape/Circle. Symbol Size: 1 

このプロットでも同様にケースを選択し、画像やそれらのデータを表示することができます。これはもう目新

しい機能ではないかもしれません。ラインプロットのシンボルをオンにすると、滑らかで起伏の少ないライン

でない限り、実際にケースがどこにあるのかを見つけることができて便利です。 
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Sessions (セッション) 

セッションという概念とともに、このレッスンを終了します。Tecplot Chorus のセッションには、作業して

いたプロジェクト、開いていたウィンドウ、デスクトップ上の位置やサイズ、および Properties (プロパテ

ィ) サイドバーにあるすべての設定が記憶されます。この機能は毎回、同じセッションを使用して常に同じ状

態から作業を開始する場合でも、操作を終了したときに保存された最後のセッションを使用してちょうど作業

が中止された状態から開始する場合でも、どちらの場合でもその状態を保存するのに便利な方法です。プロジ

ェクトと同様に、最近使用したセッションが初期画面に表示され、すぐにアクセスすることができます。 

File メニューに Tecplot Chorus セッションをロードして保存するコマンドがあります。また、Tecplot 

Chorus を終了するときに、即座にその場のセッションを保存するオプションも用意されています。練習: セ

ッションファイルを作成し、現在の作業を記録してください。それから Tecplot Chorus を終了して再び起動

し、保存したセッションを開いてください。 

最後に 

これまで Tecplot Chorus の主要な高機能を紹介してきました。まだお読みでない場合はここで『User's 

Manual』を確認することをお勧めします。Tecplot Chorus の概念とユーザーインターフェースの要素につい

て説明しており、既に学んだ内容とこのガイドの後半での説明を結びつけるのに役立ちます。 

次のような興味深いトピックが含まれています。 

 How to create projects and import data (プロジェクトを作成し、データをインポートする方法) 

使用した変数および、各ケースに対するそれらの値が Tecplot Chorus にどのように認識されるかを説明

しています。新規データを追加して、新規のケースや変数、またはその両方に使用することもできます。 

 How to set up filters so you can easily find the cases you’re interested in (興味のあるケース

の検索を容易にするフィルターの設定方法) 

フィルターはマトリクスビューと Surrogate Models (代用モデル)とも関連があります。 
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 How to create new image files using existing data files  (既存のデータファイルを使用して新規

画像ファイルを作成する方法) 

このツアーではこの機能に触れました (Tecplot360 との統合の一部)が、今後のチュートリアルで順を追っ

て説明します。 

 How to use a Surrogate Model (代用モデルの使用方法) 

まだ実行していないシミュレーションや実験の結果を近似することができ、設計空間で有益な部位を特定

するのに役立ちます。このトピックについては、今後のチュートリアルでも取り上げます。 
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SO2 プルーム移行観察 

二酸化硫黄 (SO2) ガスの排出は、工業工程で人為的に行われるだけでなく、火山噴火のような自然事象の副

産物であることもあります。酸性雨および深刻な大気汚染の元となる SO2 の排出は人間の健康および、環境

に深刻な悪影響を与えます。そのため、アメリカ合衆国環境保護庁 (United States Environmental 

Protection Agency/EPA) は、工業生産における  SO2 の排出に関して一連の厳しい産業規制を打ち出しまし

た。 

計算流体力学 (Computational Fluid Dynamics/CFD) は、さまざまな状況における製造設備の設定を検証す

る標準的方法となっています。エンジニアは、しばしば CFD を使用して、製造設備の初期設計が EPA 基準に

合致するかを判断します。 

このチュートリアルでは、エンジニアが提案した設備設計での排出が EPA 基準内の SO2 濃度に収まるかどう

かを Tecplot Chorus を使用して効果的に判断する方法について示します。EPA 基準を満たすには、排気口か

ら一定の距離における SO2 濃度が規制値よりも低くなければなりません。 

この調査のために 16 のシミュレーションが実行されました。SO2 の影響の初期評価を得るために、異なる空

気の流れと、初期 SO2 排出の組み合わせが検討されました。各調査では、複数の場所で濃度を確認しました。 

このエクササイズでは Plume (プルーム) データセットが必要です。Chorus Getting Started Bundle をダウ

ンロードすることができます。 

このデータは ZIP ファイルで圧縮されており、使用するには、各ファイルを解凍する必要があります。 

CSV ファイルの分析 

Tecplot Chorus のすべてのプロジェクトは、実行した各ケースについてのメタデータで構成されており、以

下のような情報の幅広いカテゴリを含むことができます。 

• それぞれのシミュレーションで使用あれた入力パラメータ (独立変数) 

• シミュレーションにおいて重要な出力値 (独立変数): この調査では、さまざまな場所での SO2 濃度 

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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• それぞれのシミュレーションに関する情報 (使用されたソルバー、要した CPU 時間など) を記録する情報

フィールド 

• ソルバーおよび/またはポストプロセッサで作成された補助データおよび/またはイメージファイルの名前

またはパス (それぞれのケースを参照する際に開かれる) 

SO2 データセットには、この調査のメタデータが含まれた CSV ファイル、plume_input.csv が格納されてい

ます。 CSV ファイルは任意のエディタ (メモ帳など) やスプレッドシートプログラム読み込むことが可能で、

データの表形式の特性を簡単に見ることができます。以下は Microsoft Excel の画面です。列が拡大されてお

り、各成分のすべての値を見ることができます。 

 

任意の CSV ファイルの最初の行は、各フィールド (データ項目) の名前が表示されたヘッダー行で、それぞれ

の名前はカンマで区切られます。input.csv では 12 のフィールドがあるのが分かります。 

標準の CSV ファイルでは、ヘッダー行にできるのは 1 行のみですが、Tecplot Chorus では、任意で各フィー

ルドのタイプを示す 2 番目のヘッダー行を使用することが可能です：入力パラメータ ("Independent")、出

力値 ("Dependent")、 厳密な情報フィールド ("Other"), または、ケースに関連付けされたイメージファイル 

("AuxFile")。種類は最初の行内のフィールドと同じ順序で表示されます。 

CSV ファイルに 2 番目のヘッダー行が含まれない場合、テキストエディターを使用して、簡単

に 2 番目のヘッダーを追加したり、ファイルのインポート時に Tecplot Chorus 内の各フィー

ルドの種類を指定したりすることができます。独自のヘッダー行を追加する場合は、正確なス

ペルで "Independent"、"Dependent"、"Other" および "AuxFile" を使用する必要がありま
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す。これら 4 つの特定用語以外のテキストが含まれると、Tecplot Chorus で 2 番目のヘッダ

ー行は認識されません。 

それぞれのフィールド名と 2 番目の行の種類を一致させると、以下がわかります。 

• 3 つの独立変数 (入力またはパラメータとも呼ばれます): SO2 の South East (mph), North East (mph) 

および Mass Fraction。これらは、卓越風の速度と排気口における SO2 の濃度を表します。 

• 8 つの独立変数 (outputs または results とも呼ばれる): downwind 75, downwind 50, downwind 25, 

Elev 5, Elev 15, Elev 30, Elev 100, cross wind 0。これらは、それぞれのケースのさまざまな場所の 

SO2 濃度のシミュレーションを示しています。 

• 情報変数なし (種類 "Other") 

• 単一の補助ファイルフィールド、FileName。各行のテキストの最後の部分を見ると、すべての名前が .plt 

で終わることがわかります。これは Tecplot 形式のバイナリデータファイルであることを意味します。 

ヘッダー行の後で、CSV ファイルにはケーススタディの各ケースの行が含まれます。各ケースの値は、最初

のヘッダー行内の順序になります。CSV ファイルには合計 18 行があり、2 つのヘッダー行が引かれています。

これは、事前に伝えたとおり、16 のケースが存在することを示しています。 

Tecplot Chorus Project の作成 

CSV ファイルは調査の入力と結果の “平坦” 表現です。これらのケースは恐らく、シミュレーションされた順

番で記述されており、ユーザーが作業したい順番ではない可能性があります。CSV を使用して Tecplot 

Chorus でプロジェクトを作成する場合、パワフルなリレーショナルデータベースにインポートされ、さらに

自由かつ柔軟にデータの表示と分析が可能になります。 

Step 1:  Tecplot Chorus の起動 
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まず、 Tecplot Chorus アプリケーションを起動します。例えばインストール時に作成された Windows デス

クトップのショートカットをダブルクリックします。 (Linux ユーザーは、ターミナルウィンドウで chorus 

と入力する必要があります)。 

Step 2: CSV プロジェクトを開く 

 

File メニューから Open CSV Project を選択します。これは、新規 Tecplot Chorus プロジェクトを作成す

る最も簡単な方法で、CSV 形式が完全にフォーマットされ、作業できるようになります。 

カンマ以外で区切る必要がある場合や、CSV ファイルに 2 番目のヘッダー行が存在しないため、変数の種類

を指定する必要がある場合、Tecplot Chorus はこの種類のファイルも扱うことができます。 

Step 3: 入力ファイルの選択 

Select Delimited Text Metadata File ダイアログを使用して、Plume フォルダ内の plume_input.csv を選

択したら、Open ボタンをクリックします。 

CSV ファイルから新しいプロジェクトファイルが作成されます。プロジェクトのデータベースファイル 

plume_input.chprj は、CSV ファイルと同じフォルダに作成され、同じベースネームが付けられます。After

プロジェクトファイルを作成すると、Tecplot Chorus は自動的に以下のようなテーブルビューを開きます。 
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16 のケースすべてを見ることができます。少し水平にスクロールすると、それぞれのケースのすべてのフィ

ールドを見ることができます。FileName フィールドが表示されないことに注意してください。代わりに、こ

のフィールドは、各ケースがそれぞれのデータファイルにリンクするために使用されます。これは、個々のケ

ースのデータファイルを開くときに使用されます。 

物理的可視化およびプロット画像の作成 

このエクササイズでは、Tecplot 360 を使用して、個々のケースのデータを表示し、スタイルのテンプレート

を作成して、この調査のすべてのケースの画像を自動的に作成します。 
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Step 1: Flow Solution を検討する 

まず、Table View で一番目のケース (Case ID 1) を右クリックし、コンテキストメニューから View Data を

選択します。 

 

View Data ダイアログが表示されます。 

 

ケースのデータを表示するため、このダイアログでは何も変更せず OK をクリックします。Tecplot 360 が開

かれて、データファイルが表示されます。 
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Step 2: より良い View を得るために 

これから Tecplot 360 を使用して、表示を拡大したり、回転したりして、上部に排気口がある 2 つの建造物

を詳しく見ることにします。 

まず、ズームインしましょう。 Tecplot 360 ツールバーの  ズームツールの使用により拡大することがで

きます。より簡単な方法として、キーボードで  Control キーを押しながら、マウスの中央のボタンまたはホ

イールを押し、プロット中央付近でマウスを上下にドラッグすると、拡大/縮小することができます。拡大し

て、以下のように 2 つの建造物が見えるようにします (これと全く同じように表示する必要はありません)。 
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建造物の表を上にして、プロットを回転させましょう。2 つのボックスの間にマウスポインターを置いて (ク

リックはしないでください)、キーボードの O キーを押し、回転の中心を設定します。プロットを回転したと

きに、この点を中心に回転するようになります。こうすることで、画像を回転させることなく、画面に保持し

やすくなります。 

Tecplot 360 では、ツールバーに回転用のツールがいくつか用意されています。  ローラーボール回転ツー

ルは、一般に使用されるツールのため、ショートカットが用意されています。 キーボードの Control キーを

押したまま、マウスの右ボタンを押しながら移動します。 (ご使用のコンピュータに 3D マウスが接続してい

る場合は、それを使用することもできます。) 
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回転させるにつれて、建造物が中央に配置されず (または一部が画面からはみ出して) プロットを移動する必

要があることに気付くかもしれません。ツールバーにある  Translate (または Move) ツールを使用して移

動することができます。また、これはよく使用するツールで、ショートカットが用意されています。マウスの

右ボタンをクリックしたまま、プロットを任意の位置にドラッグします。 

プロットをズーム、回転、および移動することで、Y 軸を垂直方向に真っすぐにすることが可能で、その他の

プロットはおよそ、以下の図のような方向に向けられます。 
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回転四角形の取得に問題がある場合は、ツールバーの   constrained  rotation tools (回転

制約ツール) を使用して、1 度に 1 つの軸の周りを回転させてください。 

しかし、一般に Tecplot 360 での回転、ズーム、移動のマウスショートカットの使用を覚えると、

ツールバーに移動する手間を減らすことができ、より円滑に操作することができます。簡単にま

とめます。 

- 移動: マウスの右ボタンを押してドラッグ 

- 回転 (ローラーボール): Control キーを押しながら、マウスの右ボタンを押してドラッグ 

- ズーム: Control キーを押しながら、マウスの中央ボタン (ホイール)を押してドラッグ 

プロットを回転させると、小さい方の建造物の上に点が表示されます。これが排気口です。上記のスクリーン

ショットで表示されています。 

Step 3: SO2 濃度を示すポートを介してスライスを追加する 

排気口の上の空気を通って右にスライスを追加し、平面に沿って SO2 濃度を表示します。 

最初に、Tecplot 360 Plot サイドバーの Derived Objects セクションで Slices チェックボックスを有効にし

ます (以下参照)。 
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プロットにスライスが表示され、最初に圧力で等高線に色が付けられます。 

次に、 Slices チェックボックスの隣にある  Slice ボタンをクリックして、Slice ツールを有効にします。

そして、排気口を通るようにスライスをドラッグします。 
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スライス位置は厳密である必要はありませんが、正確さを求めるならば、排気口は X = -10 です。

そのため、希望する場合は (Plot サイドバーの Slices チェックボックスの隣にある Details ボタ

ンを使用して) Dlice Details ダイアログを開き、slice position フィールドに -10 と入力してく

ださい。 

Plot メニューから Contour/Multi-Coloring を選択して、Contour & Multi-Coloring Details ダイアログを

開きます。 
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このダイアログのメニュー上部で変数を so2 に設定します。(ダイアログを開いたままにします。) プロット

が以下のように表示されます。 
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以前と同じツールを使用してプロットをズームして配置変更し、排気口に焦点を合わせて、凡例の後ろの乱雑

さを回避しましょう。プロットは以下の範囲にあるはずです。 
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最後に、ツールバーにある  Add Contour Level ツールを使用して、近くのポートに等高線レベルを追加

します。これにより、識別できる等高線レベルが増えます。排気口の左側をいくつかクリックするだけで、ツ

ールがどのようにして等高線レベルを追加するかを確認することができます。(Contour & Multi-Coloring 

Details ダイアログでも新しい等高線レベルが表示されます。) 

プロットが以下のように表示されます。 
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Contour & Multi-Coloring Details ダイアログを閉じることができます。 

スタイルテンプレートを使用する 

この例では、スタイルテンプレートを使用して Tecplot Chorus で使用する方法を検討します。 
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Step 1: スタイルテンプレートを保存する 

 

スタイルテンプレートは プロットの外観を記録する Tecplot 360 の指示ファイルですが、データは含まれて

いません。このテンプレートを使用すると、別の調査のケースでも、すべて同じ標準的な外観で簡単にプロッ

トを作成することができます。 

テンプレートを保存するには、プロットの右側にある Chorus サイドバーで、Save Style Template ボタン

をクリックします。Write Style File ダイアログを使用して、ファイル (例えば "Xslice") に名前を指定して保

存します。 

デフォルトの場合、スタイルテンプレートは、プロジェクトのルートフォルダー内、chorus に

よって生成された フォルダにある stylesheets フォルダに保存されます。このフォルダに保存さ

れたスタイルテンプレートは、Tecplot Chorus のさまざまなダイアログのドロップダウンメニ

ューに表示されます。ブラウズせずに各メニューにアクセスできて便利です。 
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Step 2: 複数のケースの比較 

作成したスタイルテンプレートを複数のケースの比較に役立てることができます。データを開いたとき、スタ

イルテンプレートを指定することが可能で、Tecplot 360 を開いたときに、それぞれのデータファイルに適用

されます。 

Tecplot 360 ウィンドウは開いたままで、Tecplot Chorus ウィンドウを前面に移動し、Table View の case 

ID 15 をハイライトします。再度右クリックしてコンテキストメニューから  View Data を選択します。 

View Data ダイアログが表示されます。ドロップダウンメニューから Xslice.sty テンプレートをクリックし

たら、OK をクリックします。 

 

新規ページに case 15 が開かれ、スタイルテンプレートが適用されます。両方のケースが Tecplot Chorus サ

イドバーの View Page セクターにリスト表示され、簡単に切り替えることができます。 

入力変数を表示するプロットにラベルを追加して、表示中のケースを識別しやすくしましょう。そのために、

Tecplot Chorus サイドバーの Label Frames セクションで、SO2 変数の South East (mph), North East 

(mph) および Mass Fraction を選択します。 

結果のプロットが以下のように表示されます。 
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Step 3: 複数のプロットの表示 

Tecplot Chorus から、一度に一つずつ、ケースを開く場合、各ケースは Tecplot 360 の独自のページに表示

されます。複数のケースを同時に開く場合には、すべてが Tecplot 360 の同じページに表示されます。 

この動作を確認するには Tecplot Chorus に戻り、Table View 内の最初の 3 つのケースを選択します。次に

それらを右クリックして View Data を選択します。View Data ダイアログで、作成したテンプレートがアク

ティブであることを確認したら OK をクリックします。 
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Tecplot 360 では以下のように表示されます。Chorus で選択したそれぞれのケースが独自のフレームに存在

します。 

 

 Zoom や  Translate ツールを使用して、任意のフレームのビューをズームしたり、パン (移動) した

りすることができます。すべてのフレームがズームされ、一緒に移動するのを確認することができます。 

ただし、一つのフレームで行った変更 (例えば、等高線カラーの変更など) は、どれも他のフレームには適用

されません。特定のプロットの外観をハイライトする目的でスタイルを変更する可能性があるためです。すべ

てのフレームにスタイルの変更を適用したい場合は、変更した後に、Tecplot Chorus サイドバー (Tecplot 

360 内) の Synchronize Styles をクリックします。この機能は、アクティブなフレームからすべてのフレ

ームに機能がコピーされます。 

Step 4: データの違いを表示する 

Tecplot Chorus を使用すると、表示中のマスターケースと他のケースの違いを視覚的に表現することができ

ます。 

 この機能は、同じメッシュを持つケースを比較している場合でのみ、正しく動作します。 



 スタイルテンプレートを使用する 

 57 

 

データ差分プロットを作成するには、マスターに指定したいフレームをクリックし、Tecplot Chorus サイド

バー (Tecplot 360 内) の下部にある Set Current Frame as Master ボタンをクリックします。 

3 つのフレームの真ん中をマスターフレームに指定して、今すぐ試してください。マスターを選択した後は 

Show Diff Data チェックボックスをアクティブにすることができます。 

以下に示すように、非マスターフレームの下に、これらのフレームとマスターとの差分を示す追加のフレーム

が表示されます。 
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差分フレームのすべてのデータ値は、マスターフレームのデータからデータを減算した結果で、新しい変数を

作成します。この値の変数は元の値と非常に異なる値を持つ可能性があるため、差分フレームには別のカラー

マップを選択することお勧めします。 

Tecplot 360 には、中央に 1 色、極値に向かって別の 2 色の陰影からなる、発散カラーマップが含まれていま

す。これにより、例えば、同じ白の領域、差分が正の赤の領域、差分が負の青の領域というように、領域を簡

単に色付けすることができます。 

これらのカラーマップのいずれかを使用するには以下の手順に従います。 

• 差分フレーム内でスライスをクリックして、確実に差分変数を選択する。 

• Tecplot 360 の Plot メニューから、Contour & Multi-Color Details ダイアログを開く。 
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• 例えば、カラー見本の下のメニューから、Diverging - Blue/Red のカラーマップを選択する。 

 

Contour & Multi-Color Details ダイアログを開いたままにします。 

• 比較するフレーム間で同じ値が差分プロットで白く見えるように、等高線の範囲を調整して確実にゼロを

中央にする必要があります。これを行うには、以下の手順に従います。 

◦ Contour & Multi-Color Details ダイアログで Set Levels ボタンをクリックします。 

 

Enter Contour Levels ダイアログが表示されます。 
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◦ Exact Levels および Min, Max, and Number of Levels ラジオボタンが選択されていることを確認

します。 

◦ Minimum Level に -0.003、 Maximum Level に 0.003、Number of levels に 15 を入力します。 

◦ OK をクリックします。ダイアログが閉じられ、新しい等高線レベルが作成されて Contour & Multi-

Color Details ダイアログに表示されます。 

◦ Contour & Multi-Color Details ダイアログを閉じます。 

• Tecplot Chorus サイドバーの Synchronize Styles をクリックします。差分データに新しい変数が作成

されたので、これは他のフレーム内のスライスの外観だけに影響します。 

結果のプロットが以下のように表示されます。 
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Step 5: イメージの生成 

保存したテンプレートを使用してイメージを生成することも可能ですが、基本的にケースの一部またはすべて

のデータの特定のビューを前もってレンダリングします。 

特に、大きなデータセットを扱う場合、すでにデータから作成してあるイメージを表示するほうが、データ自

体を開くよりも迅速です。また、イメージをサムネイルとして使用して、Tecplot Chorus の Matrix View で

視覚的にケースを整理し、アクセスすることもできます。 

次は、Xslice スタイルテンプレートを使用して、すべてのケースのイメージを作成しましょう。これを行うに

は、Tecplot Chorus の Table View で、すべてのケースをハイライトします (ショートカット: Control-A で

すべてを選択)。次に、右クリックして Create Images を選択します。 
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Create Images ダイアログが表示されます。このダイアログで Xstyle がスタイルテンプレートに選択されて

いることを確認し、OK をクリックします。 
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Tecplot Chorus は Tecplot 360 に各データファイルをロードしてスタイルテンプレートを適用し、PNG イメ

ージファイルを保存するように指示します。これはバックグラウンドで行われ、作業が行われている間、どち

らの製品も使用し続けることができます。すべてのイメージが生成されると、Tecplot Chorus ウィンドウの

下部にある、Manage Jobs ボタンの緑色のドットでバッググラウンドのジョブが完了し、結果がデポジット

されたことが示されます。 

 

Manage Jobs をクリックすると、Manage Jobs ダイアログが表示されます。 
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Manage Jobs ダイアログでは、ステータスが Ready となっているバックグラウンドジョブを選択することが

できます。次に Deposit をクリックし、イメージをプロジェクトに追加します。Append Data ウィザードが

表示され、新規イメージにタグ付けする方法を確認するメッセージが表示されます。 
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ここでは、デフォルトのタグ FileName-XSlice (元の CSV ファイルの列名に基づいてデータファイルが 

FileName でタグ付けされ、適用されたスタイルテンプレートが XSlice であったということから生成された名

前)を Xslice に変更しました。各ケースに複数のデータファイルが存在しないため、タグを含める必要はあり

ません。Next をクリックして、Append Data ウィザードの最終画面に進み、Finish をクリックして、デポ

ジット操作を完了します。 

Step 6: さらにスタイルを確認する 

このチュートリアルのダウンロードには、追加のスタイルテンプレートが含まれています。以下が含まれてい

ます。 

• BaseSliceSO2.sty 

• Pressure_top_3meter_offset.sty 
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• stream_close.sty 

• stream_far.sty 

View Data または Create Images 機能を使用して試してみてください。 

イメージを使用して調査を詳しく見る 

調査の各ケースのイメージを生成したので、Tecplot Chorus でこれらのイメージを使用することができます。

まずは Matrix view で、次に、選択したイメージを表示して比較します。 

Step 1  マトリクスビューを開く 

Matrix View はイメージのグリッドで、行と列がプロジェクト内のメタデータ変数に基づくことを意味してい

ます。 Matrix View を開くには、Tecplot Chorus ツールバーで  をクリックするか、View メニューか

ら New Matrix View を選択します。例を以下に示します。 
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Matrix View の構成は、Properties サイドバーで制御します。このサイドバーは、Tecplot 

Chorus のすべてのサイドバーと同様に、ワークスペースの任意の場所にドッキングして、

他のサイドバーを結合することができます (他のサイドバーで分割するか、タブを使用して

スペースを共有)、またはウィンドウ全体をドラッグして別の画面に移動することもできま

す。 

この例では、行に South East の風速変数、そして列に North East の風速変数を入力しました。それぞれの

行の各イメージは South East (mph) の特定の値を持つ複数のケースを表し、また、列と North East (mph) 

も同様の値を持ちます。これらの変数に特定の値を持つケースがない場合、空白のセルがマトリクスに表示さ

れます。 
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Matrix View の右下にズームスライダーが用意されており、表示するケースの数を決めることができます。逆

に詳細をどのくらい表示するかも決めることができます。 

表示値を持つ複数のイメージが存在するため、ここで、各イメージに小さな   印が表示されます (しかし、

この調査における 3 番目の独立変数の差分値を伴います)。Page By を SO2 の Mass Fraction に変更すると、

Matrix View は、この変数の各値に個別のページが提供され、サイドバーのスライダーを使用して選択するこ

とができます。これにより、シミュレーションの入力の有効値をざっと見ることが可能になり、アニメーショ

ンで結果に与える影響を見ることができるようになります。試してみてください。 

Matrix のさまざまなセルをクリックして、サイドバーの Selected Image Values セクションに目を向けてく

ださい。 

このビューの詳細についてはもう一度、Tecplot Chorus User’s Manual を参照してください。差し当たり、

Page By を None にして、初期画面に戻します。 

Step 2: 選択したイメージの表示 

Matrix View の左上のイメージを右クックし、View Images を選択します。Selected Image View が表示さ

れ、行と列の変数と同じ値の共有により、マトリクスのセルに "スタックされた" すべてのイメージが表示さ

れます (つまり、5 の South East (mph) と 5 の North East (mph) の両方を持つが、SO2 の Mass Fraction 

の値は異なる)。 
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Matrix Viewer 内で複数のセルを選択して、これらのセルに含まれるすべてのイメージを表示したり、List 

View 内でケースを選択して、これらのケースに関連付けられたイメージを表示したりすることもできます。

それぞれ異なるケース (および別の設定) からのイメージを伴って、任意の数の Selected Image View を開

くことができます。 

Selected Image View 内のすべてのイメージは、一つのケースを表します。ちょうど Matrix View と同じよ

うに、サイドバー内で選択したケースの変数値を見ることができます。このビューの詳細については Tecplot 

Chorus User’s Manual を参照してください。 
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Step 3:選択したイメージの比較 

Selected Image View を開くと、マスターとして指定するイメージを選択し、Properties サイドバーで Diff 

From Current ボタンをクリックして、差分画像を表示することができます。ここでは、最終ステップでマ

スターとして開いた Selected Image View 内の最初の画像を選択しました。 

 

Image Difference ウィンドウは、先に見たデータ差分表示に似ています。生データではなく、レンダリング

されたイメージでのみ動作します。実際のデータより正確さは劣り、インタラクティブでもありませんが、既

存の画像が存在する場合は、さらに高速で、ケースごとにデータのどの領域が変化しているのかを素早く判断

することができます。選択したケースの実データを比較して、これらの違いを更に検証することができます。 

新しい積算量を抽出する 

興味のあるすべての値がご使用のソルバーで計算されていないかもしれません。必要な結果を得るためにケー

スを完全に再実行するのではなく、Tecplot 360 CFD 解析ツールを使用して、これらのケースを計算するこ

とができます。Tecplot 360 のマクロとして操作を記録することにより、すべてのケースを適用して、新しい
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値を従属変数として Tecplot Chorus のプロジェクトに追加することができます。この方法は、個々のデータ

セットに補助データ値を設定する、任意の操作で使用することができます。 

試してみましょう。サーフェス -具体的には地面- の SO2 濃度を統合し、Tecplot Chorus プロジェクトに追

加します。 

なぜ、地上で統合するのでしょうか？二酸化硫黄は空気より重く、マッチを擦ったような刺激

臭があります。施設から近隣に異臭を放ちたくないので、SO2 濃度を地表面で最小限に抑えた

いと思います。 

Step 1: マクロの作成 

Tecplot Chorus に戻り、Table View 内で任意のケースを選択し、右クリックしてコンテキストメニューから 

View Data を選択します。View Data ダイアログで、 Style Template に None を選択したら、OK をクリ

ックします。Tecplot 360 にケースのデータファイルが開かれます。積分のマクロを記録する準備ができまし

た。これを行うには、以下の手順に従います。 

• Tecplot 360 の Scripting メニューから Record Macro を選択します。Write Macro File ダイアログが

表示され、マクロに名前を付けて、保存するフォルダを選択することができます。 

• プロジェクトフォルダにある tecplot-derived フォルダ内の macrotemplates フォルダにマクロを保存

し、groundSO2.mcr と名前を付けます。 

 Macrotemplates フォルダにマクロを保存すると、styletemplates フォルダの動作と同様

に、ドロップダウンメニューにマクロが表示されます。このように、後でマクロを適用する

ときには、保存した場所を覚えておく必要はありません。  

• Analyze メニューから、Perform Integration を選択します。Integrate ダイアログが表示されます。 
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• 上記のように、特に variable (#15, so2) および、zone (#11, ground) を設定します。そして、

Integrate をクリックします。 

インテグレーションの結果が補助データのフレームに追加され、ここで、Tecplot Chorus はこ

れらをピックアップすることができます。 (これらは単に情報としてダイアログにも表示されま

す。このダイアログは、すべてのケースに対してマクロを使用した場合は表示されません)。 
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• 2 つの integration ダイアログを閉じて、Macro Recorder ダイアログで Stop Recording をクリックし

ます。 

マクロをすべてのケースに適用し、結果をプロジェクトにインポートする準備ができました。 

Step 2: 変数の抽出 

Tecplot Chorus アプリケーションに戻り、テーブルビューですべてのケースを選択します (キーボードショー

トカット Control-A)、右クリックして、コンテキストメニューから 変数の抽出 を選択します。Extract 

Variables ダイアログが表示されます。 

 

Macro ドロップダウンメニューから作成した groundSO2.mcr マクロファイルを選択して OK をクリックし

ます。 

Tecplot Chorus はすべてのケースにイメージを作成したときと同様に、バックグラウンドジョブとしての抽

出をスケジュールします。終了している間、Tecplot Chorus および/または Tecplot 360 を使用し続けること

ができます。Tecplot Chorus ワークスペース下部の Manage Jobs ボタンに緑色のドットが表示されたら、

それをクリックし、 Extract Variables job を選択して Deposit をクリックします。Append Data ダイアロ

グが表示されます。 
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このダイアログには、それぞれのケースで使用可能なすべての補助データが表示されます。必要なのは 1 つの

みなので、残りはオフにします。 

• チェックボックス列の上にあるチェックボックスをクリックして、すべてのチェックボックスをオフにし

ます。 

• CFDA.INTEGRATION_TOTAL の横のチェックボックスをクリックしてオンにします。 

Tecplot Chorus 内の新しい変数に、さらに具体的な名前を使用するため、Display Name 列に GroundSO2 

と入力します。 

Finish ボタンをクリックします。プロジェクトの Table View で、新規変数が表示されているのを確認するこ

とができます。 
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Surrogate Model (代理モデル) を使用して新しい変数を探索

する 

新たに抽出した GroundSO2 の量がどのように動作するかの知見を得るため、surrogate model (代理モデル) 

を作成することができます。代用モデルはシミュレーションに内在する物理モデルの数値近似で、まだ実行し

ていないケースの結果を予測したり、外れ値を特定したり、最適化の研究をしたり、デザインスペースの関心

のある領域を特定したりするのに役立ちます。このチュートリアルのように比較的少ないケースの場合、代理

モデルはデータの “形状” (つまり、シミュレーションの入力と出力における関係) を把握するのに役立てるこ

ともできます。 

Surrogate Models (代理モデル) の詳細については、Tecplot Chorus User’s Manual を参照してください。 
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北東風速および、Mass Fraction (質量分率) SO2 に対する GroundSO2 の 3D 散布図を使用して代理モデル

を作成します。これにより、計算した従属変数が、これら 2 つの独立変数とどのような関係があるのかが示さ

れます。 

Step 1: 3D 散布図を作成する 

 

3D 散布図では、2 つの独立変数 (一般に、1 つの主変数および、1 つあるいは 2 つの重要度が低い変数) に対

して、3 つまでの従属変数を表示することができます。散布図を設定するには以下の手順に従います。 

• View メニューから 3D Scatter Plot を選択するか、ツールバー内の  ボタンをクリックします。 

• Properties サイドバーで以下の軸変数を選択します。 

◦ X: North East (mph) 

◦ Y: Mass Fraction of SO2 

◦ Z: GroundSO2 
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• Choose Color By Variable: GroundSO2 

その他の設定はデフォルトのままにして、Surrogate Model の設定は無視します。 

プロットが以下のように表示されます。 

 

ツールバーで   Rotate ツールをクリックして、3D 散布図内でドラッグして、視野角を変更します。深

さの感覚を得ることができますが、データが離れすぎているため、その形状を認識することは困難です。ここ

で代理モデルが役立ちます。 
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Step 2: 代理モデルのトレーニング 

3D Scatter Plot ウィンドウをアクティブにして、Properties サイドバーの Surrogate Model セクションの 

Training ボタンをクリックします。Surrogate Model Training ダイアログが表示されます。 

 

このダイアログで、目的の代理モデルの形式 (Quadratic Response Surface を使用) および、モデルに含め

る独立変数を Tecplot Chorus に指示します (この場合、プロットでの軸として２つの独立変数)。 

• Quadratic Response Surface ラジオボタンをクリックします。 

• 使用可能な 3 つのすべての独立変数を選択し、Add をクリックします。 
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16 のケースしか存在しないので、モデルのトレーニングは 1 秒しかかかりません。考慮するケース、および/

または 変数が多い研究では、さらに時間がかかります。 

Step 3: 代理モデルの表示 

 

Properties サイドバーの Surrogate Model セクションで Show チェックボックスをクリックして、代理モ

デルを表示します。以下のように代理モデルが半透明、薄い青色のサーフェスでプロット上に表示されます。 
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サイドバーに表示された R2 値に注意してください。この値は極めて 1 に近く、非常に良くフィットしている

ことを示しています。 

Step 4: プロットしない変数に評価ポイントを設定する 

プロットに表示されたそれぞれのケースにおける North East (mph) および SO2 変数の Mass Fraction は代

理モデルへの入力です。しかし、3 番目の従属変数である South East (mph) は、このプロットで使用されて

いません。この場合、代理モデルではこの変数のどのような値が使用されるのでしょうか? 評価ポイントを設

定してこれを決定することができます。 
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プロットのポイントの 1 つを右クリックして、Set Surrogate Model Evaluation Point を選択します。

Surrogate Model Evaluation Point ダイアログが表示されます。 

 

このダイアログを使用すると、それぞれの独立変数に値を設定することが可能で、その変数がプロットで使用

されない場合に、これらの変数が使用されます。この場合、South East (mph) のみが現在のプロットで使用

されているため、この変数に対する変更だけが代理モデルに適用されます。スライダーを移動し、それに応じ

て代理モデルがどのように動くかを確認したら、最小値に戻して、ダイアログを閉じます。 

Step 5: モデルの出力を検査する 

回転ツールを使用して、別の角度からプロットを確認します。代理モデルをもとに設備の物理的な動作につい

て何が分かるでしょうか? 

• 予想どおり、SO2 の Mass Fraction と GroundSO2 の関係はかなり線形です。SO2 の放出が増すにつれ

て、最終的により多くの SO2 が地上に排出されます。 

• 風速と地面の SO2 の量にはわずかに非線形の逆相関があります。風の吹きこみが強くなるにつれて、設備

付近の地面近くの蓄積が少なくなります。 

これらの結果は妥当であり、予想通りです。 
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Step 6: 外れ値の検索と分析 

Z-軸を変数 downwind 25 (25 ヤード風下のポイントでサンプリングした SO2 濃度を表す) に変更します。

何か変化に気付きましたか? プロットを表示するには回転する必要があるかもしれません。 

 

すべてのケースで入力変数と SO2 の風下濃度は非線形を示すことが予想可能で、それは代理モデルのサーフ

ェスがほとんど平坦であることで実証されます。ただし、その１つのポイントは外れ値です。 

このケースを Tecplot 360 で見てみましょう。 
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• 3D 散布図で、不要なドットを右クリックします。 (Tecplot Chorus では、すべてのビューで、ケース 

(プロットを含む) を選択することができます。) 

• コンテキストメニューから View Data を選択します。View Data ダイアログが表示されます。 

 

• None for Macro に None を選択し、Style Template に Xslice.sty を選択します。 

• OK をクリックし、Tecplot 360 にケースを開きます。 

スライス面周辺のいくつかの流線にシード処理を行い、流線による新規スタイルテンプレートを作成してみて

ください。 

• Plot サイドバーにある Streamtraces チェックボックスの隣にある  ツールボタンをクリックします。 

• スライス上でラインをドラッグして、このラインに沿ってシミュレーションした無質量粒子をシード処理

します。Tecplot 360 が、これらの無質量粒子の流れを示す流線を描画します。 

新規スタイルテンプレートを保存し、すべてのケースに新規イメージを作成して、このケースの違いを明らか

にします。streamtrace を除き、このチュートリアルでは前にすべてを実行しました。 
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Step 7: 外れ値の削除 

 

この特定のケースは代表ではないと決定して、調査から外れ値を除外すると決定することができます。3D 散

布図で障害となっているドットを右クリックし、コンテキストメニューから Mark as Inactive を選択しま

す。不適切なドットがすべてプロットから消去され、代理モデルで考慮されなくなります。 

Table View では case を見つけることは引き続き可能ですが、Case Status と呼ばれる新しい列が作成され、 

case (number 14) が非アクティブとしてマークされています。 
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Table View の Properties サイドバーにある、Use Filters チェックボックスをチェックして、Table View 内

であっても、非アクティブなケースを非表示にしたり、Filters サイドバーの下にある Case Status フィルタ

ーを使用して、非アクティブであってもすべてのビュー内でケースを表示したりすることができます。 

フィルターの詳細については、Tecplot Chorus User’s Manual を参照してください。 

次のステップ 

最初のチュートリアルでは製品概要を説明しました。本章では Tecplot Chorus の製品については多く触れま

せんでしたが、SO2 プルームの移行観察を例に、現実のプロジェクトで使用する機能を紹介しました。 

Tecplot Chorus のツールを実務で使用する方法を理解すれば、16 のケースであろうが、1600 のケースであ

ろうが、次の研究をより効果的に行うことができます。自分の研究からいくつかケースをインポートして、馴

染みのあるデータでこれらの手法を試してみることをお勧めします。 



 

86 

電動アクチュエータの最適化 

本章では航空機で使用されている電動アクチュエータの設計の最適化について説明します。以下を目指して設

計します。 

• 十分な力を生成する (得られるのであれば、より大きい力の方がよいとしても) 

• 重さとコストを抑える (使用する重くて高額なワイヤーと銅の量を最小限にする) 

• コンポーネント付近で遮断する必要がないように、磁気漏れの限界未満で保つ 

このチュートリアルでは散布図を使用して研究結果を可視化し、制約に合った設計を見つけます。 

このチュートリアル用のデータセットには 864 ケースのメタデータが含まれています。それぞれのケースに

はデータファイルは含まれていませんが、シミュレーションの結果を表示する PNG イメージが含まれていま

す。Chorus Getting Started Bundle をダウンロードすることができます。 

データセットの内部 

このプロジェクトは CSV (カンマ区切りフォーマット)ファイル、actuator_input.csv で提供されています。 

Step 1: Excel 内を検証する 

CSV ファイルを Microsoft Excel で開き、内容を確認してみましょう。 

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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上記はデータセットの一部です (CSV ファイル全体で、合計 866 行が含まれています)。L1 番目と 2 番目の行

を見ると、各フィールドの名前を持つ、通常の CSV ファイルです。オプションの Tecplot Chorus 特有のヘッ

ダーは各フィールドの種類を示しており、残りの 864 行はケースを示しています。ヘッダー行から、以下の

存在を識別することができます。 

• これらの独立変数 Z, Y および X はアクチュエータの設計パラメータを表しています。このチュートリア

ルでは、これらの値が実際に何を意味するかは重要ではありません。しかし、このケースのイメージを見

始めると意味が明らかになります。 



電動アクチュエータの最適化 

88 

• シミュレーションによって次の 6 つの従属変数が計算されます: アクチュエータによって生成されたエネ

ルギー、アクチュエータのアマーチャの量、およびアクチュエータの構成に使用した 2 つの金属 (銅とス

チール)の量、アクチュエータの磁気漏れ、およびその合計重量 

• タグ contours 付きの補助ファイル (PNG 画像)。 

Step 2: Tecplot Chorus で開く 

 

Tecplot Chorus を起動して、プロジェクトを開きます。File メニューから Open CSV Project を選択して、

用意されている CSV ファイルを Tecplot Chorus に開きます。.csv ファイルと同じディレクトリに対す

る .chprj (Chorus Project) ファイルが作成されます。.chprj はプロジェクトに新規データを追加するたびに

更新されます。そのため、今後は .csv ファイルではなく、このファイルを開いてください。 

データの Table View が開かれます。 
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プロジェクトには、すべての独立変数および従属変数とともに、CSV ファイルで見つかった 864 のケースが

含まれているのを確認することができます。各ケースのリンク画像の名前を含む contours 列だけは、テーブ

ルに表示されません。Tecplot Chorus はイメージを表示するとき、内部的にこれを使用します。それぞれの

ケースに割り当てられている Case ID を確認することもできます。 
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Step 3: 設計パラメータについて 

Matrix View を使用すると、独立変数が示す内容を視覚的に理解しやすくなり、シミュレーションへの入力が

どのように結果に影響するかを予想することができます。View メニューから、またはツールバーで 

Matrix View ボタンをクリックして、Matrix View を開きます。 

 

次に、Properties パネルを使用して Matrix View を設定します。このパネルは、デフォルトで Tecplot 

Chorus ワークスペースの左側にドッキングされています。 

• Rows を Y に設定します 

• Columns を Z に設定します 
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• Page By を X に設定します 

Matrix View の右下隅にある Zoom スライダーを使用して、個々のサムネイルのサイズを調整し、20 くらい

のサムネイルが見えるようにします。 

Page By スライダーを使用して X の値を変化させて確認します。スライダーを移動するにつれて Matrix View 

内のサムネイルが変わります。フリップブックスタイルアニメーションを使用すると、独立変数 X が、アク

チュエータの幅 を表していることが即座に分かります。 

同様に、垂直または水平にスクロールすると、Y または Z が設計に与える影響の内容を見ることができます。

Y はアクチュエータの高さです。Z の増加は磁場の強度の増加に相関があります。すなわち、Z はアクチュエ

ータの設計の奥行または厚さであり、X および Y について分かっていることに一致します。また、従属変数へ

の効果とも一致します。 

独立変数が変わるにつれて変化するサムネイル内の色の動向にも気付くかもしれません。 

イメージに凡例があるように見えます。確認してみましょう！任意のサムネイルを右クリックして、コンテキ

ストメニューから View Images を選択します。選択したケースからのイメージとともに Selected Image 

View ウィンドウが表示されます。このウィンドウで Zoom スライダーを調節すると、凡例を詳細にみること

ができるようになります。 
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凡例から、最も強い磁場に関連付けられた赤い色を確認することができます。そのため、一般的に言えば、イ

メージに赤い色が増えるほど、その設計で磁場が強くなると解釈することができます。この知識を持って、

Selected Image View ウィンドウを閉じることができます。そして、 Matrix View 内のサムネイルをざっ

と確認することで、各アクチュエータの設計で生成された磁場の強さと、各入力変数がこの特性にどのように

影響を与えているかの概要を素早く判断することができます。 

最後に Matrix View の各ページで 8 つのケースの 9 つの行、または合計 72 のケースが示されることを確認

します。プロジェクトにおけるケースの合計数の 864 を 72 で割ると、ちょうど 12 となります。これは、す

べてのパラメータの離散値のすべての組み合わせにケースが存在することを強く示唆しています。これは ”ス

パース” プロジェクトではありません。”欠落” またはシミュレートされていないケースはありません。 
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そのため、ズームを設定して各ページですべての 72 のケースを表示できるようにし、Page By スライダーを

使用して X の値を変化させます。すべてのケースにサムネイルがあり、この調査では X の離散値が 12 あるこ

とがすぐに分かります。 

行または列を交換して、X を表示し (Page By 変数を None に設定)、 X の離散値をそのようにカ

ウントすることもできます。 

Matrix View を使用して、データセットについて多くのことを学びました。しかし、このビューを使用するだ

けでは、どのケースが設計目標を満たしているかは分かりません。 

制約の可視化 

制約を可視化するとフィルターを使用して調査のどのケースが設計の成功基準を満たすかを確認することがで

きます。まずは、Tecplot Chorus の View メニューまたは、ツールバー で  2D Scatter plot ボタ

ンをクリックして、2D Scatter Plot を開きます。 

Properties サイドバーで、X Axis を Weight に設定、Y Axis を Fy に設定し、Coloring セクションで Color 

by Filter Violations を選択します。最初のプロットが以下のように表示されます。 
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上記の画面キャプチャでは、Filters サイドバーをワークスペースの右側にドッキングしました。

このサイドバーは幅広く使用されます。Properties および Filters のどちらにもアクセスできる

ことが便利な場合がよくあります。どのサイドバー・パネルもワークスペースの任意の側にド

ッキングすることができます。また、Tecplot Chorus のメインウィンドウの外に完全にドラッ

グして第二の表示にすることもできます。 

このプロット内のすべてのドットが調査のケースを示しています。調査内のケースは選択可能で、右クリック

すれば Table View、Matrix View ほか、Tecplot Chorus におけるすべてのビューと同様にイメージを開くこ

とも可能です。1 つのビューで選択したケースは、すべてのビューで選択されます。 

ケースを選択するだけで、一つあるいは複数のケースに関連付けられた値を確認することができます。ワーク

スペースの下にある Selected Cases パネルには、これらのケースの変数だけが表示されます。 (このパネル
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が開いていない場合は、View メニューから開くことができます。) 選択したケースだけを表示する場合を除

き、Table View と同様に動作します。 

 

プロットの網かけ部分は、Filters サイドバーで追加した制約外の領域を示しています。これらの制約をまだ

定義していないため、プロット内のすべての調査が網かけ領域外 (または、制約のない白色の領域) にあり、

個々のドットはすべて緑色です。 (選択したケースは濃い 緑色です。) 

 

どの設計が目標の基準に合致するか決定したいので、主に従属変数のフィルタリングに興味があります。

Filters パネルを管理しやすいように、他の変数を非表示にしましょう。 Filters サイドバーの上部にある歯車

アイコンをクリックし、ドロップダウンメニューから Select Filters to Include  を選択します。Select Filters 

to Include ダイアログが表示されます。 
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このダイアログで Independent および Other グループのチェックを外し、OK をクリックします。Filters サ

イドバーに従属変数のフィルターのみが表示されます。 

ここで、基準に合わないケースを除去するフィルターを設定します。まずは、Weight フィルターが  0 から 

1.95 (最大制限重量)のみを表示するように設定します。次に、Force が 22 以上のケースだけを表示するよう

に設定し、最後に Leakage を 0.01 未満に設定します。目的の Filter 設定が右側に表示されます。 
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以下は 2D 散布図での、これらフィルターの結果です。 
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この調査では、ほとんどのケースが網かけ領域に存在しており、ほとんどの設計が重すぎたり、十分な力を作

り出していなかったり、磁気漏れが多すぎたりすることを示しています。赤のドットは、これらの基準の 2 つ

以上に反しているケースを示しており、青のドットは 1 つの基準に反しているケースを示しています。 

白い部分の右下隅が関心領域です。これらの設計のいずれかは基準に適合していますか? すべての基準が満た

されているケースを表す緑のドットがあるかどうかを確認するのは困難です。拡大してさらに詳しく見てみま

しょう。 
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• Tecplot Chorus ツールバーで  Zoom (拡大) ツールを選択します。 

• 2D 散布図で関心のある領域の周囲を四角くドラッグします。「許容範囲」と「許容範囲外」のラインの境

界が確認できるように、網かけ部分の一部を含めます。 

 

拡大すると、役立ちそうなケースを示す緑のドットがいくつかあることが分かります。4 つ、厳密には 1 つの

正確な重量制限が許容範囲であると仮定します。 
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銅は高価なので、別のフィルターを追加して、設計で使用する銅の量が 3.5 未満となるようにしましょう。こ

の規則はケースを 1 つ除外します。白い領域の最上部のこれまで緑だったケースが青になりました。さらに、

以前は青だった多くのケースが赤に変化し、これらのケースが銅の制約に反していることを示しています。 
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役立ちそうに見える 3 つのケースがあります。緑のドットをすべて選択します。 

• ツールバーで  Select (選択) ツールを選択します。 

• 2D 散布図の緑のドットのいずれかをクリックします。 
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• Control キーを押しながら 2 番目と 3 番目のドットをクリックします。 

右クリックして、コンテキストメニューから View Images を選択します。条件に合った、3 つのアクチュ

エータとともに、Selected Image View ウィンドウが表示されます。 

 

どのイメージがどのケースでしょうか? ラベルを追加しましょう。Properties サイドバーで Select Labels ボ

タンをクリックして、 Labels Images ダイアログを開きます。 

 

このダイアログで Case ID, Z, Y, X, Fy および Weight をオンにしましょう。 
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OK をクリックして Label Images ダイアログを閉じます。次に Properties サイドバーで Show Labels チ

ェックボックスをオンにします。各ケースの下の Selected Images View ウィンドウにラベルが表示されま

す。 
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これらは機能する 3 つの設計です。これらすべてをレポートに含めます。 

しかし、以下に示すように１つが明らかに他よりも優れています。 

 

この設計は、その重さに対して必要以上の優れた力を生成し他の方法よりも軽量です。またこれは、限界に達

していないため若干 “余裕” も残されています。その他、より多くのエネルギーを生成する唯一の設計は、正

確な重量制限です。また、もし航空機で他の設計を選択して制約が厳しくなると、恐らく最初に仕様から外れ

ます。 
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そのため、指示された設計をお勧めします。右クリックして、View Images を選択します。拡大して、ラベ

ルをオンにします。 

 



電動アクチュエータの最適化 

106 

これです。もし、このケースにデータファイルがあれば、これを Tecplot 360 で開くことができ、詳細で高品

質のプロットを作成することができます。 

次のステップ 

これまでの 3 つのチュートリアルで Tecplot Chorus の主要な機能を検討してきました。 

• Table View および Matrix View 

• 2D 散布図、3D 散布図、および Line (ライン) /Symbol (シンボル) プロット 

• Selected Items パネル 

• フィルターおよび制約の可視化 

• 個々のケースからのデータの可視化と比較 

• イメージの表示と比較 

• スタイルテンプレートとイメージの生成 

• 新しいメタデータ値の抽出 

• Surrogate models 

これで独自のプロジェクトで Tecplot Chorus を使用する準備ができました。取りかかりましょう!  
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COPYRIGHT NOTICE 

Tecplot Chorus™ Getting Started Manual is for use with Tecplot Chorus™ Version 2024 R1. 

Copyright © 1988-2024 Tecplot, Inc. All rights reserved worldwide. Except for personal use, this manual may not be reproduced, transmitted, transcribed, stored in a retrieval system, or translated in any form, in 

whole or in part, without the express written permission of Tecplot, Inc., 3535 Factoria Blvd, Ste. 550; Bellevue, WA 98006 U.S.A. 
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Tecplot, Inc. Documentation is provided for information only. It is subject to change without notice. It should not be interpreted as a commitment by Tecplot, Inc. Tecplot, Inc. assumes no liability or responsibility for 
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Post Office Box 52708 
Bellevue, WA 98015-2708 U.S.A. 
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users arising out of the use of this software, even if advised of the pos- sibility of such damage. Copyright © 1998-2006 The Board of Trustees of the University of Illinois, Copyright © 2006-2008 The HDF Group 

(THG). All Rights Reserved. PNG Reference Library Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc., Copy- right © 1996, 1997 Andreas Dilger, Copyright © 1998, 1999 Glenn Randers-Pehrson. All 

Rights Reserved. Tcl 1989-1994 The Regents of the University of California. Copyright © 1994 The Australian National University. Copyright © 1994-1998 Sun Microsystems, Inc. Copyright © 1998-1999 Scriptics 

Corporation. All Rights Reserved. bmptopnm 1992 David W. Sanderson. All Rights Reserved. Netpbm 1988 Jef Poskanzer. All Rights Reserved. Mesa 1999-2003 Brian Paul. All Rights Reserved. W3C IPR 1995-

1998 World Wide Web Consortium, (Massachusetts Institute of Technology, Institut National de Recherche en Informatique et en Automatique, Keio University). All Rights Reserved. Ppmtopict 1990 Ken Yap. All 

Rights Reserved. JPEG 1991-1998 Thomas G. Lane. All Rights Reserved. Dirent API for Microsoft Visual Studio (dirent.h) 2006-2006 Copyright © 2006 Toni Ronkko. Permission is hereby granted, free of charge, 

to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, 

publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so. Toni Ronkko. All Rights Reserved. ICU 1995-2009 Copyright © 1995-2009 

International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the 

"Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the 

Software is furnished to do so, provided that the above copyright notice (s) and this permission notice appear in all copies of the Software and that both the above copyright notice (s) and this permission notice appear 

in supporting documentation. International Business Machines Corporation and others. All Rights Reserved. QsLog 2010 Copyright © 2010, Razvan Petru. All rights reserved. QsLog Copyright © 2010, Razvan Petru. 

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above 

copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation 

and/or other materials provided with the distribution. The name of the contributors may not be used to endorse or promote products derived from this software without specific prior written permission. THIS 

SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABI- LITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE 

FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUEN- TIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 

SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Razvan Petru. 

All Rights Reserved. VTK 1993-2008 Copyright © 1993-2008 Ken Martin, Will Schroeder, Bill Lorenson. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must 

reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither name of Ken Martin, Will Schroeder, or 

Bill Lorensen nor the names of any contributors may be used to endorse or promote products derived from this software without spe- cific prior written permission. THIS SOFTWARE IS PROVIDED BY THE 

COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSE- QUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABIL- ITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
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OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Ken Martin, Will Schroeder, Bill Lorenson. All Rights 

Reserved. 
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